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Welcome to QuickBooks 2005

STEP 1 Install QuickBooks

If you're upgrading from an earlier version of
QuickBooks, you must verify and back up your
company file before installing QuickBooks 2005. 

From the File menu, select Utilities, then Verify Data. Follow
the on-screen instructions.

From the File menu, select Back Up. Back up to a different
directory than where QuickBooks is installed. It's best to back
up to a CD.

If backing up to a CD, you'll first need to save the backup file
(.QBB) to your hard drive, then burn the backup file to the CD
with your CD writing software.

1 Shut down all programs that are open, including any virus
protection software.

2 Insert the QuickBooks Installation CD into your CD-ROM drive.

TO VERIFY

TO BACKUP

Follow these steps to install, create or update
your company file, and activate QuickBooks.

a Click the              button and select Run.

b Type the letter associated with your CD-ROM drive, then type
:\autorun.exe and click OK.

If the installer doesn't start, you'll have to start it manually.

QuickBooks Payroll Service — the only payroll service
that’s completely integrated with QuickBooks

Don’t get penalised by the
government — we follow the 
tax laws so you don’t have to.

To make life even easier for small businesses, you can also use QuickBooks
to manage your payroll. It’s the only payroll service that fully integrates
payroll, tax filing, reporting and accounting with QuickBooks — which means
you only ever need to enter data once.

Designed for small businesses, QuickBooks Payroll updates your
QuickBooks accounts simultaneously.

* File your payroll returns online and get up to £825 tax free 
from the Inland Revenue!

* Automatically calculate Income Tax and 
National Insurance

* Print and issue payslips

* Keep track of payroll liabilities

* Manage Statutory payments (SMP, SSP, SPP)

* Calculate Tax Credits & Student Loans

* Allows for 99 Employees per company/Multiple Companies

* Includes reports for P11, P14/P60, P35

* Issue P45 to leavers

* Includes free Tax table updates during your subscription period

For further information or to subscribe call 
0845 606 2161.

e-file
CERTIFIED
by Inland Revenue
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5 If the Transfer Existing Settings window appears, accept the default
settings and click Next.

6 At the QuickBooks Anonymous Usage Survey window, keep the I agree
to send anonymous usage statistics to Intuit tickbox selected to
participate in our help tracking survey.

With the Anonymous Usage Survey turned on, QuickBooks tracks the
help topics that you open while using the software. With this data, we
are then able to improve QuickBooks for the future. We do not track
any personal or financial data about your company.

7 Follow the remaining instructions until the software is installed, then
restart your computer.

For instructions on installing the QuickBooks Pro Timer, refer to the
User Guide. The Timer is a separate program that can track and record
time data which you can then import in to QuickBooks Pro and higher.

WHAT’S NEXT The next step after you’ve installed QuickBooks 2005 is to
create a company file in QuickBooks or (if an existing user) update
existing company files. See Create or update your company files on
page 6.
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3 When prompted, enter your Installation Key Code (IKC), then click Next.

WHERE CAN I FIND MY IKC? A unique IKC is assigned to each QuickBooks
software package. The location of the IKC is different depending on how
you purchased QuickBooks. Use this table to help you locate your IKC.

Store your IKC in a safe 
place in case you need to 
reinstall QuickBooks.

4 At the Install Options window, choose where you want QuickBooks to 
be installed.

If you want to install
to the default direc-
tory, click the Next
button at the bottom
of the screen.

To install to a different
directory than the
default, click the
Change new
directory button, then
specify your new
directory.

If the software detects that Internet Explorer (IE)
version 6.0 is not installed on your computer, this
tick box is selected. Do not clear this tick box if it
is selected. IE 6.0 is needed for QuickBooks to 
run properly.

QUICKBOOKS PURCHASED IKC PROVIDED...

in a retail store on the back of CD case

by calling Intuit directly over the phone, or
on the invoice

through the Web site by e-mail

Install QuickBooks (continued)
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UPDATING EXISTING COMPANY FILES

If you are upgrading from QuickBooks 2004 or earlier, you need to
update your existing company file(s) to the 2005 format.

1 Open QuickBooks 2005, then open your existing company file.

2 QuickBooks prompts you to update your company file. Type Yes, then
click OK.

3 Before the update process begins, you’ll be asked to back up your
company file again.

Save this backup file to a location that is different than the backup file
you were asked to create when installing QuickBooks. Having more
than one backup is recommended in case one becomes corrupt or the
update process is interrupted in any way.

You must be in single-user mode to update company files.
If you’re in multi-user mode, go to the File menu and select 
Switch to Single-User Mode.

If you can’t find your company file(s), select Search from the 
Windows          menu on your taskbar. Search for a file with a 
.QBW extension.

If you need help setting up your company file, refer to 
Chapter 2 of the User Guide.
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If you are new to QuickBooks, your next step is to
create a company file. Read the section CREATING A
NEW COMPANY FILE.

If you are currently running QuickBooks 2004 or earlier
and are upgrading to QuickBooks 2005, you need to
update your company file. Read the section UPDATING
EXISTING COMPANY FILES on the following page.

CREATING A NEW COMPANY FILE

1 Open QuickBooks. Click the QuickBooks icon on your 
desktop, or from the Start menu, go to Programs and select
QuickBooks. QuickBooks may take some time to open
depending on the speed of your computer.

2 On the Welcome window, click the Create a new company
button.

Click here to create a new company file.

WHAT’S NEXT The next step after you’ve created and set up your
company file is to activate your software. See Activating
QuickBooks on page 9.

STEP 2 Create or update your company files
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You must activate QuickBooks within the first 6 uses
of the product. Activation is a fast and easy process
that validates you as the licenced user of this
software. If you have a multi-user licence, you must
activate QuickBooks on each computer where you
have QuickBooks installed.

If you wish to activate QuickBooks at a later time,
click the Cancel button on the QuickBooks Activation
window. You can open the Activation wizard again by
going to the File menu and selecting Activate
QuickBooks. You’ll be reminded periodically to
activate until the sixth use at which time, if you still
have not activated QuickBooks, you will no longer be
able to add or edit data in your company file.

1 Open QuickBooks 2005. Then open your company file (if you
have not done so already).

The Activation wizard is displayed. If you don’t see 
the Activation wizard, go to the File menu and select 
Activate QuickBooks.

STEP 3 Activate QuickBooks

If you use the Internet, make sure you are connected to it
before you start activating QuickBooks.
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4 When QuickBooks tells you that your file is updated, click OK. Update
any other company files that you have.

5 When you have finished updating your file(s), close QuickBooks.

WHAT’S NEXT The next step after you’ve updated your company file(s) is to
activate your new software. See Activating QuickBooks on page 9.

Click OK on this window to back
up your file. After your file is
backed up, QuickBooks begins
the update process. This process
may take some time especially if
you have a large company file.

While QuickBooks is updating
your file, it may seem like the
software is “frozen”, but this is
usually not the case. A good 
rule of thumb is if you see this
cursor    and the hard drive light
on your computer is flickering,
then QuickBooks is not frozen.

Don’t attempt to shut down
QuickBooks while it is updating
your company file as it could
damage the file.

Create or update your company files (continued)



QuickBooks eXceed
Support is a dynamic
combination of 
online and telephone
support for all
QuickBooks users.

eXceed Support

When you join the eXceed
community, you’ll discover a wealth
of information and assistance
which will enable you to get the
most out of QuickBooks.
eXceed Support membership also
gives you exclusive access to our
Data Recovery service (additional
costs apply). This is a vital
component of our support,
designed to combat the escalating
number of computer viruses.

* UNLIMITED TELEPHONE SUPPORT
9.00 am to 5.30 pm, Monday 
to Friday

* INSTANT MESSAGING for immediate
technical support, 9.00 am to
5.30 pm, Monday to Friday

* LIVE CHAT learn how other
businesses operate, share
knowledge and network

* TRAINING online training,
feature demonstrations and 
walk throughs

* TOOLS currency converters,
financial year calendars and
much more

* SUPPORT online technical
support, with frequently asked
questions and help on getting
started

* DATA RECOVERY exclusive to
eXceed members, can you afford
to be without it?

* PASSWORD REMOVAL available
only to eXceed members

* ONLINE INFORMATION available 24
hours a day, 7 days a week
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2 Click Next on the QuickBooks Activation window and follow the on-
screen instructions.

You will activate by phone or through the Internet.

> ACTIVATING BY PHONE If you activate QuickBooks by calling us, the
QuickBooks representative will ask you for your Product Key number.
You can find this number on the same screen that prompted you 
to call us. The QuickBooks representative will then give you a 
Licence Key number which you must enter in the Licence Key field.
This field is also located on the screen that provided your Product
Key number.

> ACTIVATING THROUGH THE INTERNET If you are prompted to activate
through the Internet, the software sends your product information to
Intuit and automatically activates your software for you. This is a safe
and secure process.

WHAT’S NEXT Now you are ready to begin using QuickBooks to do 
your accounting. The first thing we recommend that you do is read the
User Guide.

When you have activated QuickBooks, you can see the details of 
your licence information by going to the Help menu and selecting 
My Licence Information.

For further information
call 0845 606 2161 or
visit our Web site at
www.quickbooks.co.uk

These benefits are only available to eXceed
support members, yearly subscription applies.

Activate QuickBooks (continued)



The quick, safe and secure
solution to making
controlled and accurate
payments to employees
and suppliers by BACS*
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QuickBooks 
e-Payments Solutions

CONTROL CASH FLOW When you
initiate an automatic electronic
payment, you know precisely which
day it will be cleared from your
account. You then know what funds
need to be in your account on that
day to fund the payment.
PAY ACCURATELY every time, and no
re-keying of payments is necessary
at all.
MAKE FASTER PAYMENTS No need to
write out cheques and post them:
BACS payments are cleared in
three days. Pay salaries and bills
into Banks or Building Societies 
via BACS.
SAVE TIME AND MONEY Issuing a
cheque can cost several pounds,
if you include bank charges,
postage, signatories' time and 
staff procedures. QuickBooks 
e-Payments Solutions will reduce
that cost to just a few pence 
per transaction.

BE SECURE No need to have cash
on premises, no lost or stolen
cheques. Payments are cleared
straight into your payee’s bank
account at exactly the same time
as the funds are drawn from yours
with full traceability.

QuickBooks has teamed up with leading online
payments specialist WorldPay (part of the Royal Bank of
Scotland Group) to provide QuickBooks Card Solutions
— to help businesses process online payments.
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Simple, efficient and secure
online payment system

Save time and reduce errors
Why waste time entering
transactions into a terminal and
again into your books? Just enter
them once in QuickBooks!
Processing starts the moment you
save, and you'll know the results in
seconds.

Streamline credit and debit card
transactions 
E-mail invoices or statements and
accept credit and debit card
payments online, your customers
can pay you as soon as they
receive your invoice.

Save money

* No additional hardware, swipe
terminal or dedicated phone
required

* Reduce defaults on payments

* Reduce administration costs

* Provide payment choices for your
customers

* Free WorldPay Customer Service
available from 8.00 am to 
8.00 pm, Monday to Saturday 

For further information
call 0845 606 2161 or
visit www.worldpay.com/
quickbooks

For further information
call 0845 606 2161 
or visit us at
www.btpayments.com

QuickBooks Card Solutions allows you to accept payment from Visa,
Mastercard, Amex, Switch and Laser. Your customers can pay you online
and you can process and enter transactions directly from within
QuickBooks. As it's integrated with QuickBooks, it also saves you time, so
you can concentrate on running your business.

* Subscription charges are applicable.

Powered by
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With QuickBooks Customer Manager you can be a
mouse click away from everything you need to know,
about every customer you have! QuickBooks Customer
Manager integrates seamlessly and synchronises with
QuickBooks 2005 and Microsoft Outlook data*

Get back to do 
what you do best

Provide customers with a better
more attentive service
Customer Manager shows you
everything you need at a glance.
Your customers don’t need to wait
while you search for project,
appointment, financial or 
contact information.

Instantly see the value of 
every customer
Customer Manager puts all your
QuickBooks financial data at your
fingertips. It even shows you
customer’s balances, allowing you
to jump directly into their entries in
QuickBooks for in-depth details.

Become more productive
It doesn’t just streamline your day
and eliminate the drudgery of

constantly typing the same
information! Customer Manager also
allows you to keep abreast of
important dates and tasks, leaving
you with more time to concentrate
on your business.

Easy to set up
An easy five step set-up wizard
means getting started should 
only take you about 30 minutes.
Customer Manager also comes with
a 30 Day Money Back Guarantee.

When money is on the line, it’s important that you put
your best foot forward. Intuit Stationery helps you
project a professional image for your company.

Statements, purchase orders,
estimates, invoices, payslips...

PERSONALISE Stationery made even
more impressive when you add
your company logo.
GUARANTEED TO FIT Our business
forms are 100% guaranteed to fit
your software.
BUY ONLINE Simply log on to
www.intuitstationery.co.uk and
choose the stationery you require,
method of payment, delivery option
and the product will be delivered
to your door.

* BT Trustwise secure encrypted
transactions

* All major credit/debit cards
accepted

* Special deals on pricing for web
ordering

* Next day delivery available

* 24 hour ordering

For further information 
or to order call 
0845 606 2161. 

Simply call one of our QuickBooks business form
experts on FREEPHONE 0800 279 5285

* Synchronises with Microsoft Outlook 2000,
2002, 2003 and Outlook Express 5.5 and 6.



30 Day Money Back Guarantee

In the event you determine that you are not satisfied with the
software, you may obtain a full refund of the purchase price you
paid* for the software and Payroll Service (if applicable) if within
thirty (30) days of purchase you:

1 Send to the address below: all items provided to you as part of the
Software or Payroll Service and original copy of documentation evidencing
the date and amount you paid for the Software (e.g. dated receipt,
shipping invoice);

2 Delete any Software, Payroll Service and documentation downloaded or
loaded onto your computer; and

3 Destroy any and all copies made by you (or with your permission) of any
portion of the Software and Payroll Service. In order for us to process your
refund satisfactorily, please complete the following:

I hereby declare that I am no longer using the software and have deleted it
from the hard drive and any subsequent copies made. (Intuit Ltd reserves
the right to inspect this at any time.)

NAME

ADDRESS
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The QuickBooks Accountant
Edition offers advanced
features that truly meet a
professional accountant's
unique needs.

Get even better control of 
your accounts

Remote access to client data 
The QuickBooks remote access
service lets you use your computer
to directly access a QuickBooks
company file on a different
computer. Check details in client
files, enter changes, set up a new
company file, or train your clients
on QuickBooks without ever leaving
your desk.

Journal Entries 
Work faster with better controls by
using new Journal Entry options: 
* One-click general journal entry

reversal 
* Automatic numbering of journal

entries 
* Auto-filling journal memo fields 
* A memorised report for Journal

Entries Entered Today 
Reversing an entry creates a new
entry — dated the first day of the
following month — that reverses the
debit and credit amounts.

Reconciliation Reporting 
Be more productive by saving and
viewing previous reconciliation
reports and view a summary report
of all client changes made since
the last reconciliation.

Report Templates 
If you have a particular report you
would like your clients to run, set
up the report as a memorised
report on your own computer and
then export the report settings as a
report template. Your clients then
import the template and run the
memorised report using their own
QuickBooks data.

For further information
or to order call 
0845 606 2161. 

PLEASE SEND BY REGISTERED POST TO

Intuit Ltd, PO Box 4944, Twyford, Reading, Berkshire RG10 9BF

* Minus applicable shipping and handling fees.



Benefits from the Intuit
Professional Advisors
Programme

QuickBooks advice is 
never far away

Intuit can help you find advice in
your local area from an accounting
professional who understands
QuickBooks and can advise you on
small business issues. Your Intuit
Professional Advisor is ready to
provide one-on-one advice that will
help you make your business more
efficient and productive.

Intuit Professional Advisors
provide a full range of services
including
* Report generation &

interpretation of QuickBooks
data to help you make better
business decisions

* Payroll set-up & monitoring
* Preparation & production of

year-end accounts
* Staff training & development

from complete novice to expert
* Technical support in accounting

for VAT, payroll & taxation
* Strategic business planning &

cash flow forecasting

Interested in becoming an Intuit
Professional Advisor?
If you are an accounting
professional, small business
consultant or trainer, you can
become a member, subject to
approval, of the Intuit Professional
Advisors Programme.

To find a Professional
Advisor visit
www.quickbooks.co.uk/
findaproadvisor or call
0845 606 2164
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